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QUICK START 

This section is designed to give you a quick look at CleverPsych. Everything is described in 

more detail in the following manual. 

You can also look at demonstration videos and screen-shots on the web site 

https://sourceforge.net/projects/cleverpsych/. 

 

1. After you have downloaded and run the CleverPsych.exe file the system should 

start up using the demonstration database. You can try it out immediately, but we 

recommend that you spend a little time to skim through the following chapters. 

2. You must install Java to use CleverPsych. Java is a standard computer language. It 

is embedded in your browser, and your phone and is used in your on-line banking 

system. For more information about Java go to www.java.com. 
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1. INTRODUCTION 

1.0 Background 

The CleverPsych system is developed by the Clever Company; hence the name. Our 

directors and employees are a professional software developer and his wife a clinical 

psychologist who runs the part of the company trading as Monaro Psychology Services, 

which we refer to as MPS.  

In late 2007 the developer started work on a system that could record MPS clients and 

their appointments with the aim of making frequent operations like generating standard 

letters, claiming from the government and insurance companies, and reporting income much 

easier. 

We think that the software would be of use to other psychologists who run small 

practices like MPS, so we are making it available. 

CleverPsych is cheap. You can use it to evaluate and learn the system, but you will 

need to purchase a licence later. 

However, we give no guarantee as to the correctness or suitability of the system. You 

use it entirely at your own risk. We won’t pay you any compensation no matter what happens. 

If you don’t agree; don’t use the software! 

 Refer to the Legal appendix for a longer version. 

Having said that, we use the software ourselves so do our best to ensure that it works 

correctly. 
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We have computers running Windows7 and Windows8. We use a VMWare virtual 

appliance to test the linux releases. Mac releases are checked on a Macbook Pro. We use 

word from Office 2007 and 2010. Most psychologists will have something similar. 

CleverPsych will theoretically run on lots of platforms and you can certainly use other word 

processors and spreadsheets e.g. OpenOffice. 

You might consider running CleverPsych on a laptop, so you can always have all your 

client information with you. 

1.1 This manual 

As CleverPsych is cheap it is necessarily developed and supported in our spare time, 

so we are trying to supply a comprehensive manual that will tell you everything you need to 

know.  

You should work your way through the manual and use the supplied demonstration 

database and support files. When you have done this you will know how to use CleverPsych 

and have a system configured for your practice. Demonstration videos are available on 

https://sourceforge.net/projects/cleverpsych/. 

We expect that most users of CleverPsych will have a good working knowledge of 

Windoze, but we will tend to supply too much detail just in case. This extra information will 

be coloured so you can skip over it if you like. 
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2.0  GETTING STARTED 

2.1 Installation 

CleverPsych is supplied as a file named CleverPsych.exe. To install the system you 

run this file (double click in windoze explorer). 

You have probably already done this to obtain this manual. 

The UNIX (linux, Mac) installation is from ZIP files and is described on the web site. 

2.2 Updates 

If you already have CleverPsych installed, then after unzipping an update you will 

continue to use your CleverData folder, but you may have to update some of the files from 

the new CleverDemo folder. See the chapter at the end of the manual. 

2.3 Files 

Installation will give you three directories (folders in MS-speak) in the C: drive. 

▪ CleverPsych contains the software. 

▪ CleverDemo is a demonstration database etc that you use to learn about the 

system.  
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▪ CleverData is initially a copy of the CleverDemo folder, but without the 

sample clients and their appointments. This will hold your data. 

TopDirs.png – Basic folders 

 

2.4 Java 

The system is written in the Java programming language. Java is extremely widely 

used for applications, in web pages etc. It even runs in mobile phones. 

Before you can use CleverPsych you need to install java. This normally happens as 

part of the installation process. 

If CleverPsych did not start when you installed it, you should check to see if you 

already have java installed by running the CheckJava.cmd script in C:\CleverPsych\Scripts. 

This runs the command “java –version” and may produce something like: 
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If either you do not have java installed or the version is less that 1.6.22 you must 

install Java. This is usually done by the setup script. You can download the latest version of 

the Java runtime System (JRE)  from the Java site www.java.com. 

If you buy a new computer you may have to download the latest version of Java. 

 

The old version of the MEDICARE software uses 32 bit Java, the latest 64 bit Java. 

2.5 Running the demo / tutorial 

When you install CleverPsych two icons are placed into the C:\CleverPsych directory. The 

setup script copies them to the desk top. 

 

You can start up the CleverPsych demonstration by clicking on the Demo icon (this 

runs the script CleverDemo.cmd in the CleverDemo\scripts folder). 

The other icon is used later to start CleverPsych for your own data.  

There are other icons to start from dropbox etc. 

2.6 Configuring Windows 

http://www.java.com/
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CleverPsych continually runs background tasks to: 

• Send reminders. 

• Clean up the disk 

• Backup the database 

• Send daily appointment lists 

• Claim from medicare 

• Etc 

For this reason you usually need to have your computer running all the time.  

If you have a laptop you should consider plugging it in at home overnight or when in 

your office and configuring the system for when the background processes are run. 

You need to go into the Control Panel, select Power Options, and make sure that 

powering off is set to “Never”. Restart your computer afterwards. 
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2.7 Automatic Start 

We find that Microsoft updates our computer on Saturday nights, and the computer restarts. 

 

This means that CleverPsych is not running, so the reminders for Monday are not sent. 

 

You may have noticed that you have a folder called "Startup" in your Programs menu. 

Anything you put into this folder, Windows will launch on startup—so setting an app to 

automatically launch is easy: 

 First, select the CleverPsych icon. Right-click on it and hit "Copy". This will copy the 

shortcut. 

 Find the Startup folder in All Programs and right click on it. Hit "Open", and it'll open up in 

Windows Explorer. 

 Right click anywhere inside that window and hit "Paste". Your desired program's shortcut 

should pop right up in the folder, and the next time your computer starts, that program will 

automatically start up. 
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3.0  THE BASICS 

3.1 Introduction 

When you start the system (by clicking the Demo icon) the main screen appears. You 

will find that you need to zoom in and out via the “+” and “-“  buttons on your PDF viewer to 

see the detail of some of the pictures in this manual. 

 

The left side of the screen shows your clients and their appointments (with the latest on the 

top) as a “tree”. You can expand and contract the tree and select clients and appointments in a 

similar way as how you use Windows Explorer. 

The definition of the selected client appears in the right pane with any selected 

appointment below it. 
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Definition of clients, appointments etc is done by typing into the appropriate fields 

and clicking a button to insert into or change values in the database 

 

So try defining a new client, using the buttons below the client pane:  

Click the Clear button to initialise the fields. 

Type the given name and surname. 

Select a title (Mr, Mrs etc) 

Select a client type e.g. Private. 

Click the New button under the client pane to store the client in the database. The 

client will appear at the bottom of the tree and a message will appear at the bottom of the 

window. 

 

Next give the client an appointment: 

Select an appointment time. 

Most fields will have been filled out according to the client type. 

Click the New button below the appointment pane. 

The appointment will appear in the tree and a message will appear at the bottom of the 

window. 

 

Next try modifying the client. Perhaps enter an Email address.  

Click the Modify button below the client pane to store the changes into the database. 

A message will appear at the bottom of the screen. 

3.2 Tool Tips 
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If you “hover” the mouse cursor over a button, field or menu item some text will pop up that 

will provide some brief information. 

3.3 Buttons 

Storing of information into the database is controlled by sets of buttons below the 

relevant fields on the screen ( by a field we mean where data such as a name is displayed and 

entered). 

 

Generally the process is: 

▪ To enter new data (such as an appointment) click the Clear button  to blank 

the fields or set them to default values. You can then type values into the 

fields. 

▪ To actually store some new information (such as a new client) into the 

database you click the relevant New button. 

▪ To modify a displayed definition type the new values into the fields and then 

click Modify to set the new values in the database. 

▪ To delete the currently displayed definition from the database click the Delete 

button. Hence you could delete a simple definition such as an appointment, but 

if you delete a client all of its appointments will also be removed. In practice 

you will seldom delete anything. 

The important point is that there are no changes to the data stored in the database 

unless you click a button. This means that if you change your mind after typing in something 

the original is still stored. There is no “undo” function (unless you restore the database from a 

backup). Be careful to click from the correct set of buttons. 
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3.4 Colours 

The system use the “traffic lights” colouring system. i.e. 

Red(ish) is bad 

Green(ish) is good (as usually is black) 

Orange(ish) is somewhere in between 

For example, if you type clear to input a new client the two name fields that must be 

entered are coloured red and other fields that you should enter (but can leave for now) appear 

yellow. 

Similarly the appointments in the tree should be green. If not some data has to be 

modified. Client names are also coloured in the tree. 

The text used in the tree for clients, appointments and services is colored according to 

status. The colours used can be listed from the Help menu. 

 

The icons are coloured in the tree to indicate when there is a problem (you can display 

a validation report, probably for all clients and their appointments to find what is wrong). 
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3.5 Error Messages 

Messages appear at the bottom of the window when you initiate a process e.g. click a 

New button.  

Messages are coloured as above i.e. green if successful, yellow if successful but you 

should do something, and red if the operation failed and you need to fix the problem. 

3.6 Screen Layout 

The screen has been designed to run on our old low resolution monitors. 

You can use the usual operations of making the window full screen if you too cant 

afford the latest, or can expand it to a larger size. 

You can also “drag” the bars to make the tree wider or to change the size of the 

appointment area. 

So far we have only discussed clients and their appointments, but you can click on the 

“tabs” to show other information. 

Hopefully this is all standard stuff as far as you are concerned. 

3.7 Nagging 

The philosophy of the system is that you are seldom forced to do anything, but if you 

should, something (usually a field and the tree) will be coloured yellow. If you must do 

something it is coloured red. 

For example, you will often enter a new client and a first appointment without 

knowing much about them so fields like date of birth could be yellow. 
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For example you don’t have to input the fee for an appointment, but if you don’t the 

fee field will be yellow, and after saving into the database the appointment icon in the tree 

will also be coloured. However, should you display a report of your income it will not be 

accurate. 

The aim is to have everything in the tree coloured green! 

3.8 Configuration 

The system can be configured for your type of clients and the way that you work. This 

will be covered later, but briefly, the system is controlled by “configuration files”. 

For example a client’s title (Mr, Mrs etc) is chosen from the pulldown in the Client 

definition pane which is loaded from a configuration file. You can change the list by editing 

the file. 

For example if Captain Kidd walks through you door you can add “Captain” to the 

configuration file (and hence to the pulldown list). Then you can use his title when adding 

him as a client. 
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3.9 Command Window 

When you start the system a command prompt window also appears. 

 

This window shows the commands that are run to start up CleverPsych. More 

importantly it will display error messages if there is something wrong with your system. 

You can change the properties on the icon (right click) so the window is minimized. 

The default window does not show many lines. You can click on the top left icon to 

show the properties and then increase the default maximum lines (e.g. to 5000 as below). You 

may want to change the font size too. 

You can use the Edit menu to select all and copy. Then you can paste the contents into 

an Email if you need to advise support@cleverpsych.com.au  of a problem. 

mailto:support@cleverpsych.com.au
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3.10 Multiple Users 

CleverPsych is essentially a single user system. In particular only one running 

program can access the database at the same time. 

If you inadvertently start up a second copy you will see a message like: 
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You should exit at this stage if another version is running. The option to carry on is 

only for the case that the database has been left in a funny state. This can happen if your 

previous use of CleverPsych did not exit cleanly e.g. you powered off your computer. 

You can run multiple CleverPsych versions on the same computer. See later. 

3.11 Licence 

You may use CleverPsych to evaluate and learn the system. 

At some stage you will need to purchase a licence from our web site. We will mail 

you a licence file which you have to place into the c:\CleverData\config folder. 

The Australian MEDICARE extensions can only be used when you have purchased a 

separate licence. 
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4.0  CLIENTS AND 

APPOINTMENTS 

4.1 Introduction 

The first we hear of a new client is usually when they ring for an appointment. We 

may receive a secure Email from a Doctor (or Insurance company) providing further details. 

For example if a new client Santa Claus rings and says his doctor has told him to call 

and that he is under the BOiMHI (Better Outcomes in Mental Health Initiative) government 

scheme you can click the client Clear button and type in the minimal information for the 

client and click Add, and then enter an initial appointment in a similar way. 
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The first thing you will notice is that some fields are yellow signifying that you 

should enter some value. Which fields are required are specified when the client type is 

defined. Most government and insurance types will require a reference number. There is 

much more said about this later. 

4.2 Clients 

Hopefully most client fields are obvious, but some other details are: 

▪ The given name and surname fields must be given as together they uniquely 

identify the client. We usually use just one given name. If by chance you have 

two clients with the same name you have to differentiate between them e.g. 

give an initial or second name. 

▪ The client has a status, which may be reset when the system starts. You can 

add a client to the wait list by setting it to “Waiting for an appointment”. The 

client is displayed in the tree according to the sttaus. 

▪ The mobile phone numbers are used for sending reminders, so input them if 

you can. Usually there is just one mobile number, but you can provide more, 

separated by commas, if the reminder should go to more than one person. 

▪ The Email is used for reminders if there is no mobile number. 

▪ The date of birth is required by our secure Email system. 

▪ A K10 test is often done by the referring doctor before and after a session so 

you can record the scores. 

▪ The referring doctor can be selected from a pulldown list. We cover definition 

of referrers later. 
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▪ An insurance company or other organisation can be selected from a pulldown 

list. We cover definition of organisations later. 

▪ The date of the current referral should be given (or first contact). 

▪ The total number of appointments and number for the current referral are 

displayed and used to detect the middle session, which can be highlighted. 

▪ If you have a new client who has had several sessions with another 

psychologist you can set an initial count for the referral. The current number 

of appointments + the initial count can be output in a document e.g. to provide 

a current session number. 

▪ The memo field can be used for a quick reminder.  If the action reqd flag is 

ticked the client will be coloured in the tree. 

▪ You can configure the list of tests and use it to record those given to the client. 

▪ A check list can be set up to remind you of the procedure you have done. We 

would often send an acknowledgement letter to the doctor, give a PAI at the 

first appointment, send a mid-session letter requesting further treatment, and 

have some final administration after the final session. 

4.3 Client Directories 

When you create a client a directory is set up for them under the clients directory. 
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To allow for the large number of clients in your practice, the directories are actually 

stored under another level of directories that is the first letter of the surname (if you change a 

client’s name you will have to manually move the directory). 

You can use these directories to store any client files. CleverPsych stores client files 

such as letters there. 

The files in a clients folder are displayed in the tree. Clicking a file will display it in 

your word processor (which may not always be possible). 

 

4.4 Appointments 

Appointments are identified by their time. 

As with clients, there are some subtleties about the appointment fields. 

The appointment status has fixed values and has to be reset after the appointment: 

▪ New patient – indicates a first appointment. 

▪ Scheduled – a new appointment. 

▪ Paid cash – a cash client attended and paid. Used for income that does not 

appear on your bank statements. 
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▪ Paid cheque – a cash client attended and paid with a cheque. 

▪ Paid card – a cash client attended and paid with a credit card. 

▪ Paid other – a cash client attended and paid by some other means. 

▪ Owed– a cash client attended but did not pay. The tree icon is red. 

▪ No show – did not turn up. This is a major problem. See reminders later. 

▪ Cancelled – phoned to say they could not come. You usually do this rather 

than delete the appointment as it indicates unreliable clients. 

▪ Claimed – you have submitted a claim for payment to the government or 

insurance company. The system will indicate when you have been slack and 

have not claimed within a reasonable time. 

▪ Attended – the client came to the appointment (you may need to claim) 

▪ Invoiced – you have sent an invoice. 

▪ Rejected – your claim or invoice was rejected and you need to send a revised 

one. 

Details of other appointment fields are: 

▪ Fee and tax are loaded with values defined in the configuration, but you can 

change them. Tax to us is the Goods and Services Tax (GST) which applies to 

some services. We record GST as 10% on top of the basic fee, but you can 

handle tax any way you like (consistently!) e.g. included in the fee. 

▪ Client type is set to that of the client. However the type can change e.g. 

someone may first attend as a private patient and the go to a doctor and enter a 

government scheme. This field enables old appointments to display their type 

at the time. 

▪ Service number is a configured list of government or insurance service 

identifiers. 
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▪ Reminded tells if a reminder has been sent to the client. 

▪ In external database can be used when you have to enter appointment details 

in a government database. 

▪ Group appointment can be set to enable more that one client to attend at the 

same time. Normally the system will only allow one appointment at a time. 

 

You can generate a sequence of appointments by creating a new appointment that is 

the first in the sequence (get it right!) and then clicking the Recurring button to display the 

dialog: 
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5.0  SERVICES 

Services are a “catch all” for income-generating activities other than appointments. The most 

usual for us are psych. reports, but could be a presentation or a course etc. 

Services are defined and displayed in the tabbed pane next to the appointment in 

much the same way as appointments are. 

Services have a time which is usually when the report is scheduled to be written or 

when the service is provided. You can use it for any purpose. 

You use the Clear and New buttons to enter a referrer and the Modify button to put 

any changes into the database in the usual way. 

For example, to process a report you might: 

• Select the Services tab. Click clear and select “Forensic Report”. Check the 

fee and set the date to when you expect to start. This puts an entry into the 

diary. 

• While writing the report, set the status to “In progress” and change the date 

and hit modify to save a series of times into the diary. 

• When the report is finished send it to the insurance company. Set the service 

date to when sent and the status to “Claimed” (and click Modify). This does 

not change the diary. 

• Later set the status to paid, change the date and Modify. 

 

Note that diary entries are only generated for “New service” and “In progress”. 
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 26 

6.0  REFERRERS 

Doctors and other persons who refer clients to you are defined in the “Referer” tab and are 

defined in a similar way to clients and appointments. 

You use the Clear and New buttons to enter a referrer and the Modify button to put 

any changes into the database in the usual way. 

 

 

 



 27 

After referrers have been defined they appear in the pulldown on the client pane so 

they can be referenced by clients. 

To modify the definition of a referrer choose from the pulldown in the client pane. 

When a client is chosen any referrer is displayed in the referrer pane. 

We expect that you will only have a small number of referrers. 

You should not delete a referrer if it is referenced by a client. 

 

Referrers are identified by their name and reference / provider number. You can have 

more than one entry for a doctor who works at several medical practices, and has a different 

provider number for each practice. 
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7.0  ORGANISATIONS AND 

ASSOCIATES 

Organisations that ask you to provide services or to see clients are defined in the 

“Organisations” tab and are defined in a similar way to referrers. 

Associates are people who you do business with (other psychologists, psychiatrists, 

parole officers etc). 

You use the Clear and New buttons to enter an organisation and the Modify button to 

put any changes into the database in the usual way. 

 

 

After organisations  have been defined they appear in the pulldown on the client pane 

so they can be referenced by clients. 
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To modify the definition of an organisation choose from the pulldown in the client 

pane. 

When a client is chosen any referenced organisation is displayed in the referrer pane. 

We expect that you will only have a small number of organisations. 

You should not delete an organisation if it is referenced by a client. 

Associates are handled in a similar way to organisations and referrers. 
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8.0  DIARY 

Our practice was originally run with a diary and a mobile phone. 

Clients ring to make appointments, often at odd hours as the phone is off most of the 

day, and the new appointment is written into the diary.  MPS typically uses one hour 

appointments. At a convenient time the appointment (and new client information) are entered 

into CleverPsych. 

Hence the diary is the ultimate record of activities within our practice. 

We now have a secretary who enters everything into CleverPsych. 

CleverPsych provides a diary view of appointments and services. You can use it the 

select appointments and to set appointment times, but the ultimate use is as a check that you 

have entered data correctly. 

Hence the CleverPsych diary should look the same as your paper one. 

You select the Diary tab to see the current diary page. 

Diary entries change as you define and modify appointments and services: 

▪ Appointments are shown as the client name. 

▪ Services are displayed as the type e.g. Forensic report. 

▪ Group appointments are shown as “Group”.  See below. 

▪ Cancelled appointments are shown as “Cancelled”. You can assign these times 

to someone else. 

Problem entries are coloured. 
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When you select an appointment or service in the tree the relevant diary page will be 

shown. You can skip weeks backwards or forwards by clicking the arrow buttons. You can 

also input a date and click the Page button to skip to the page containing that date. 

If you click on a “Group” appointment entry a list of the clients will pop up and you 

can select a client’s appointment. 

 

 

 

You can reserve a period of time by clicking the Reserve button to display the dialog: 
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You give the time range and reason. 

The diary will be coloured and the reason displayed. 

Reserved slots act as a background and appointments and services within the range 

will still appear. 

You can remove a reservation by clicking in the range and using the Unreserve 

button. 
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9.0  FILTERING 

The tree usually displays a subset of your appointments and provided services; typically just 

the past month (the demo system is a special case and displays from the start of 2008 so all 

the example data appears). 

This has the effect of making the tree much smaller and makes it easier to select 

appointments and clients. 

A major reason for filtering is that it defines the data to be processed e.g. you may 

wish to display your income when you are doing your Tax return. In that case you set the 

time range to the financial year, filter, and then display the report. 

You can specify the appointments to be displayed and processed by setting values in 

the Filter tab. 

 

Filter.gif 

The various fields are used as follows: 
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▪ Date range – retrieves appointments and services with dates within the range. 

Also retrieves clients who have their current referral date within the range. 

▪ Client type – displays a dialog from which types can be selected. 

▪ Appointment Status – displays a dialog from which status can be selected. 

▪ Service Status – displays a dialog from which status can be selected. 

▪ Client –  retrieves clients who have the typed string in their name (case 

insensitive) 

▪ Referrer –  retrieves referrers who have the typed string in their name (case 

insensitive) 

▪ Organisation –  retrieves organisations that have the typed string in their name 

(case insensitive) 

▪ All – is a quick way of showing everything in the database. This also retrieves 

clients who have no appointments. 

Clicking some buttons display a dialog from which several types or status can be 

selected. The selection remains until changed. 
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Be aware that the client icons in the tree are coloured according to whether the client 

and all appointments are valid. This means that the client can be coloured red, but the 

displayed client fields are all valid and the displayed appointments and services are 

green. This means that some appointment or service that has been filtered out has a 

problem. 
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10.0  WORD PROCESSOR 

10.1 Introduction 

You can generate letters in your word processor by selecting the relevant appointment 

or service in the tree and then selecting a type of letter from the Word menu. 

The letters are actually generated using template files in Microsoft rich text format 

which contain know text strings that are replaces by values from the selected client, 

appointment, service or referrer. 

You should be able to use a variety of word processors such as Microsoft Word and 

OpenOffice. 

10.2 Example 

The following letter was generated by selecting Daisy Duck’s first appointment and 

the selecting “Referrer acknowledgement” from the Office menu. 
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We cover in more detail how to generate template files for your own letters and how 

to add the letters to the Office menu later. 

If a letter does not appear in your word processor when you try an example it means 

that CleverPsych cannot find your word processor. The system will try and use wordpad 

(from Start->All Programs->accessories)  as a last resort. See the configuration chapter. 



 38 

11.0  REPORTS 

11.1 Introduction 

The CleverPsych system can generate several reports. The process is: 

▪ Filter to get the data that you wish to report on. 

▪ Select a report from the report men 

▪ The report will be displayed in the Report tabbed pane. 

▪ Select the “Word” item from the Report menu if you wish to load it into your 

word processor (and hence into another report). 

11.2 Example 

If you select the Clients report you will see something like the following: 
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If you then load the report into the word processor (using the Reports->Word menu 

item) you will see: 
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Every report is written to a file Report.rtl in the tmp directory, and selecting the Word 

menu item simply reads that file into the word processor. You will probably find that only 

one report can be loaded into the word processor at a time. 
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12.0  PLOTS 

Plots and histograms can be produced in much the same way as reports i.e. filter to 

display the appointments and services you are interested in and then select a type of diagram 

from the Plots menu. 

The plots appear in the Plots tabbed pane. 

For example, if you select the “Plot appointments” menu item you will see something 

like the following: 

 

Several types of histograms can be displayed too: 
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13.0  RELATIONSHIPS 

DIRECTED GRAPH 

Clients, their appointments and provided services and related referrers and 

organisations can be displayed as a directed graph by selecting a layout method from the 

Relationship menu. 

Such graphs can become very cluttered, so the procedure is to filter the data first to 

select clients or referrers or organisations and then select what is to be displayed. 

 

• The zoom buttons can be used to change the view of the graph, as can the 

wheel on the mouse. 

• The picking mouse lets you select a transaction or item which will appear in 

the Transaction tab. You can also drag objects around. 
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• The transforming mouse enables you to distort the graph. Holding down Ctrl 

or Shift keys while dragging give different effects. 

The buttons at the bottom let you display or hide services, appointments, referrers and 

organisations. 
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14.0  MISCELLANEOUS OPTIONS 

14.1 Introduction 

The “Misc” tabbed pane contains the “odds and ends”. Currently this is reminders to do 

backups ,parameters for importing basic data and creation of copies of CleverPsych for 

multiple psychologists. 

 

 

14.2 Backups 
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While we know that you diligently back up your data, we suspect that not everyone 

does so. 

You enter the date into the Misc pane when you do a backup, and the system will 

remind you to do another one after a few days. The number of days is a configuration item 

and is usually set to 7. 

 

 

We suggest that you back up your system at least once a week, so when the disk on 

your computer has a psychotic episode you can reinstall your software and data onto a new 

disk having only lost a few days appointments and clients. 

We backup using CD’s, and the procedure on Windows Xp is: 

▪ Put a new CD into the drive. 

▪ A window pops up, and select “Open writable CD folder using Windows 

Explorer”. This gives you an Explorer window for the CD drive. 

▪ Open another Explorer window, probably for the C: drive. 

▪ Drag the folders you want to back up into the CD driver window. You need 

your data directory e.g. CleverData and probably the CleverPsych folder. 

Backup anything else of value too. 

▪ You will have to wait for files to be copied. 

▪ When all folders are in the CD Drive Explorer window select “Write these 

files to CD” and the CD Writing wizard appears which controls the actual 

writing. 
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We suggest that you sometimes check that the data are actually on the CD. There have 

been many cases where, after some disaster, it has been found that the data could not be 

recovered from the backup. 

You should keep your backup CD’s somewhere away from your computer so that 

when your office burns down you still have your data. If you use a laptop and take it home 

don’t keep your CDs there. You get the idea. 

 

These days we put the CleverData folder on Dropbox, which means the data are held 

on the cloud. See the web site. 

14.3 Multiple CleverPsych Systems 

If you want to run multiple copies of CleverPsych on one computer so each 

psychologist in your practice has their own folder with database, letter prototypes etc, you 

can do so from the Misc tab. 

The procedure is: 

Set up the system for one psychologist i.e. get the letter prototypes correct and all 

relevant configuration done. This is the basic system using the C:\CleverData folder. When 

you are satisfied with this, for each other psychologist: 

1. Type a single word name into the name field e.g. Fred, and click the Duplicate 

button. 

2. A  new folder will be created (here C:\CleverDataFred) that is basically a copy 

of the CleverData folder. 

3. A desktop icon will appear that can be used to start CleverPsych for Fred. 

4. Edit the main configuration file and letter templates as necessary. 
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14.4 Importing Appointments 

There is a very basic facility for importing clients and appointments where you 

already have them on your computer in some form. This is designed to be used when you 

begin to use CleverPsych. 

You use the “Comma Separated Values” (CSV) format that is supported by 

spreadsheets. The aim is to set up your data in a spreadsheet in the supported way, export it as 

a CSV file and then import that file into the system. 

If you have your data in a file e.g. a report, you can turn it into a CSV file with say 

NotePad, import it into Excel, manipulate it, and output it as a CSV file for importing.  If the 

report is in word format, export it as a text file. 

Confused? The best way is to start with the demo system: 

Select the File->Export menu item. This will write the file  

CleverDemo\tmp\Export.csv and load it into your spreadsheet. 

 

 

Given Name, Surname, Reference,,,,,,,, 

Daisy,Duck,,7 Jan 2008 12:00 PM,9 Jan 2008 03:30 PM,14 Jan 

2008 12:00 PM,21 Jan 2008 12:00 PM,28 Jan 2008 12:00 PM, 

Donald,Duck,,7 Jan 2008 09:00 AM,9 Jan 2008 03:30 PM,14 Jan 

2008 10:00 AM,21 Jan 2008 10:00 AM,29 Jan 2008 10:00 AM, 

Grumpy,Dwarf,,9 Jan 2008 08:00 AM,16 Jan 2008 08:00 AM,23 Jan 

2008 08:00 AM, 

Snow,White,XX54343646,7 Jan 2008 11:00 AM,14 Jan 2008 11:00 

AM,21 Jan 2008 11:00 AM,28 Jan 2008 11:00 AM, 
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The file gives the spreadsheet column values row by row, where the values are 

separated by columns. There are only a few columns supported, which are in order: 

▪ Given name 

▪ Surname 

▪ Reference number 

▪ Repeated appointment date and times (for each) 

This is extremely simple but does enable existing appointments to be entered. 

To load the data into your database 

▪ Delete the existing database (we assume you are just starting). 

▪ Start CleverPsych 

▪ Select File->Import menu item and choose the CSV file. 

▪ The data will appear in the tree. 

▪ You then have to add client data and referrers. 

 

The main problem is that your CSV file could have dates in various formats. You can 

define the formats you want to use in the Misc panel. You can give both import and export 

formats. 

 If your data has appointment dates but not times, you can set the flag in the Misc 

panel. In this case times will be given as the appointments are entered. 

Date formats are those used by the Java SimpleDateFormat class. Some of the 

documentation is in an Appendix. You can also google to find out more. 

For example CleverPsych uses the format “dd MMM yyyy hh:mm a” which prints 

dates and time in the form 25 Dec 2003 10:30 AM. 

Good luck! 
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15.0  CONFIGURATION 

15.1 Introduction 

Much of the behaviour of the system is controlled by several configuration files, which are 

held in the CleverData\config folder. 

ConfigDir.png 

You usually change the files by selecting from the Config folder. You can also edit 

them directly with a text editor such as NotePad or wordpad (from the Start->Accessories 

list) or with Word.  

When you edit a configuration file, the changes may be applied immediately, but 

often you need to restart CleverPsych. 

You should be careful about deleting items from a configuration file. Make sure that they are 

not being referenced by something in the database. For example, if you added “Sir” to the 

titles configuration file to enter Sir Les Patteson, its not a good idea to remove it later. 

Many config files provide a list that appears, or from which you can select, in the 

panes. You should also order the list as appropriate. 



 52 

15.2 Main Configuration 

Most of the system specifications are held in a single configuration file 

Configuration.txt. 

Entries are on a single line: 

▪ Lines starting with # are a comment. Rather than deleting lines you should 

consider “commenting them out” as configuration items have a habit of 

coming back. 

▪ Lines have the format NAME=VALUE 

▪ When there are multiple values they are commas separated. This will become 

obvious later. 
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Many of the entries are described later, but some extraneous ones are: 

▪ Keep backups=31 – The system automatically backs up your database into the 

backup directory. This is the number of days those backups are kept (here a 

month) 

▪ Keep tmp=7 – The system writes some temporary files into the tmp directory.  

This is the number of days those files are kept (here a week) 

▪ Keep logs=7 – Some logs are generated in the logs directory. This is the 

number of days to keep the logs. 
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▪ Backup period=7 – When you backup your system you should enter the date 

into the Misc panel. The system will remind you to do another after this 

number of days. 

▪ Information about you, for example: 

Psych Title=Dr 

Psych First Name=Crazy 

Psych Surname=Horse 

Psych Full Name=Dr Crazy Horse 

Psych Mobile=04123456 

Psych Mail=crazy@gmail.xyz 

Psych Phone=0598765432 

Psych Fax=12344321 

Psych Provider Number=1234567A 

Psych Address=123 Main Street, Hicksville, New York. 

 

 

15.3 Titles List 

We have already looked briefly at changing the titles list. To do so select the Config->Edit 

titles menu item. 

 

The title list is used when inputting names i.e. it loads the titles pulldowns / combo 

boxes. The default title is in the top of the list. 
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You usually add titles as required. For example, if Princess Diana walks through your 

door you would add “Princess” to the list. If most of your clients are Princesses you would 

put the entry at the top of the file. 

15.4 Tests 

You can tick the tests that you have given to a client.  

 

Use the Config->Edit tests list menu item to maintain the list of the tests that you use. 
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15.5 Check List 

CleverPsych enables you to set up a check list to remind yourself of the common steps you 

go through with client treatments. 

 

Use the Config->Edit check list menu item to set up your own check list. 
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15.6 Marital Status 

Use the Config-> Edit marital status list to change the marital status pulldown list. 

 

15.7 Service Numbers 

Use the Config->Edit service number list menu item to maintain the pulldown from which 

you can select service numbers. 
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Use the Config->Edit services list menu item to maintain the pulldown from which you can 

select the types of services that you offer (reports, courses etc). 

You can also set the fee for all service numbers in the main configuration file. The 

service number list has the service code as the first word e.g. 

80005 MEDICARE Clinical Psych - out of rooms - (30-50 min) 

80100 MEDICARE FPS Service - in rooms - (20-50 min) 

80105 MEDICARE FPS Service - out of rooms - (20-50 min) 

 

You can set the fees in the main configuration with entries like: 

# Service code fee lookups 

80010=119.80 

80015=140.15 

80000=81.60 

80005=102.00 

80100=57.80 

80105=78.65 

80110=81.60 

80115=102.50 

N0124=250.00 

 

  

15.8 Client types 
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You can define your types of clients. You will probably use some of the supplied 

types and add some of your own. Don’t delete or change the standard entry “Pro bono” as it 

is checked for in the software. 

Generally if you several clients of a particular type and in particular if you have a 

special charge for that type of client, you should set up a client type in the list. 

For example, if your office is close to a university and a lot of your clients are 

students, and perhaps you offer a discount for them, then you should set up a “Student” type. 

The first step is to select “Edit client type list” from the Config menu and add Student 

to it. 

 

The second step is to select “Edit configuration” from the Config menu and set up 

some entries for the new Student type. You will find it easiest to “clone” entries for existing 

types. A student type is similar to the Private type, which has entries like: 

Private_FEE=110 

Private_TAX=0 

Private_SESSIONS=0 

Private_CLAIM=0 

Private_CHECK= 

 

So you set up entries like the following, where your fee is say $60. 
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Student_FEE=60 

Student_TAX=0 

Student_SESSIONS=0 

Student_CLAIM=0 

Student_CHECK= 

 

It is probably obvious that the name has to be exactly the same (here Student) in both 

configuration files. 

The entries mean the following: 

▪ Student_FEE=60 – what you charge 

▪ Student_TAX=0 – tax to be paid. You can decide whether it is added to the 

charge or included, but be consistent. 

▪ Student_SESSIONS=0 – the number of sessions for the referral. Used for 

government schemes or Insurance allocations, but not relevant here. 

▪ Student_CLAIM=0 – the system will remind you to claim after this number of 

days (irrelevant) 

▪ Student_CHECK= - gives a list of client and appointment compulsary fields. 

None here. Described below. 

For a more involved example, here are the entries for the BOMiHI scheme: 

▪ BOiMHI_FEE=110 

▪ BOiMHI_TAX=0 

▪ BOiMHI_SESSIONS=12 – each referral is for 12 sessions 

▪ BOiMHI_CLAIM=30 – We usually claim every two weeks, but will be 

reminded after a month. 

▪ BOiMHI_CHECK=RefNo,Referrer,DOB,K10,ExtDB – A reference number is 

required, the referring doctor must be specified, date of birth is required, the 

doctor must supply a K10 test result and data has to be entered into the 
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BOMiHI web site. When you create a new BOMiHI client you will have 

several yellow fields until you supply the data. 

 

The checking flags are given as a comma separated list, and are: 

▪ DOB – you should supply the date of birth 

▪ ExtDB – you should enter data into another organisations database on their 

web site 

▪ Group – the types has group appointments so the flag will be set by default 

▪ K10 – the doctor should supply the results of a K10 test 

▪ Referrer – you need to supply a doctor or Insurance company contact. 

▪ RefNo – a reference number is expected. 

▪ Service – you should enter a service number. 

You should edit the client list and remove or rename the types. Then you should edit 

the main configuration and set the fees you charge and create any new types. We suggest that 

you leave entries for types that you don’t use as you may want them as models later. 

15.9 Configuring Word Processors and Spreadsheets 

Your word processor and spreadsheet are started by CleverPsych by using the 

configuration files WordProcessor.txt and SpreadSheet.txt respectively. If you can display 

letters then you will not have to do any configuration.  

If you upgrade your system and your word processor no longer starts, copy the 

WordProcessor.txt file from the CleverDemo/config folder, and look at the comments. 

These files need to contain the names of the executable files. For example if you run 

the file C:\Program Files\Microsoft Office\Office11\winword.exe on our system, Word will 
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appear. The actual file name depends on the version of office (or other software) that you 

have. 

On Mac OS X, the open command is used to start word processors. 

 

 

The supplied configuration as supplied will execute some versions of word that we 

know about. It will not work if: 

▪ You have some other version of word. 

▪ You installed into a non-standard place. 

▪ You are using other software. 

If Word does not start up you need to find out where it is installed. Use the Start-

>Search facility and look for the file name WINWORD.EXE. The select the “Config->Edit 

word processor run” menu item and set up a file. All you need is a single line similar to that 

displayed. Note the quotes, which are required because of the blanks in the file names. 
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Similarly, if your spreadsheet does not appear you need to search for the file 

EXCEL.EXE and edit the configuration file using the “Config->Edit Sreadsheet run” menu 

item. 

 

If you are using OpenOffice you need to search for swriter.exe and scalc.exe and edit 

the files as above. You will need files that look something like: 

"C:\Program Files\OpenOffice.org 2.4\program\swriter.exe" for the word processor, 

and 

"C:\Program Files\OpenOffice.org 2.4\program\scalc.exe" for the spreadsheet. 
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16.0  RUN TIME 

CONFIGURATION 

16.1 Introduction 

This section describes: 

• Changing the diary range and intervals 

• Handling more than one psychologist 

• Changing screen colours 

If this is of no interest, ignore this chapter. 

16.2 Multiple Psychologist Practices 

CleverPsych is essentially a single user system. For example nothing is stored in the 

database to connect appointments with any particular psychologist. In particular only one 

running program can access the database at the same time, as already explained. 

There are several things to consider in practices with several psychologists and 

perhaps support staff. 

If your practice has several psychologists who have their own rooms and own 

computers then they can each run their own systems independently. 

If you want to run a CleverPsych system for each psychologist in your practice on the 

same main office computer you can set them up using the Misc tab. See the relevant chapter. 
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If your computers are on a network where all of them have shared drives, then you 

should put one copy on the CleverPsych directory on the shared drive so you only have to 

replace it in one place to install a new version. If your client data are confidential you should 

leave the CleverData directory on each PC’s C: drive. If your client data are shared (e.g. the 

owner of the practice wants to see how hard you are working or the secretary inputs client 

data for you) you should set up a directory for each practitioner on the shared drive. Give 

them obvious names like CleverFred, CleverSonia etc. You will then need procedures to 

make sure only one person accesses the databases at a time e.g. the secretary updates them on 

the days that you play golf. 

When you have set up each of your directories you need to tell the system about them 

and give each psychologist in your practice their own icon to start up CleverPsych for their 

own data. 

See below. 

16.3 STARTING CleverPsych 

The supplied icon to run the program actually executes the command file 

C:\CleverData\scripts\CleverPsych.cmd. You can edit this file from the Config menu, or 

directly e.g. with Notepad. 

The file has some comment lines and looks like: 

rem This is the title that appears at the top of the window 

set TITLE="CleverPsych Demonstration" 

 

rem Where all the data are kept 

set DATA=c:\CleverDemo 

 

rem The software location 

set SOFTWARE=c:\CleverPsych 

 

rem The name of the database 
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set DATABASE=Database.xml 

 

rem These are the diary and time/date selection ranges 

set STARTHOUR=8 

set ENDHOUR=20 

 

rem This is the diary interval - one of 10, 15, 20, 30, 60 

set MINUTES=30 

 

rem The Java Look and feel 

rem Standard windoze 

set LAF=Win 

rem Standard java L&F 

rem set LAF=Java 

rem NimROD L&F. Give the name of a theme file from the config folder e.g. 

rem set LAF=NimROD.theme 

rem set LAF=Burdeos.theme 

rem set LAF=DarkGrey.theme 

rem set LAF=DarkTabaco.theme 

rem set LAF=LightTabaco.theme 

rem set LAF=Night.theme 

rem set LAF=Snow.theme 

 

Then you can change the first few lines as appropriate’ 

16.3.1 CONFIGURING FOR MULTIPLE PSYCHOLOGISTS 

You need to edit the CleverPsych.cmd (above) file. 

1. The title to appear at the top of the screen to differentiate from 

other psychologists e.g. set TITLE="CleverPsych for Psuper Psych  

Fred" 

2. The data folder e.g. set DATA=c:\CleverFred 

3. Where the basic software is if on a shared drive e.g. set 

SOFTWARE=X:\CleverPsych 

4. The database name if several users are sharing the same directory 

e.g. set DATABASE=FredDatabase.xml 
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16.3.2 CONFIGURING THE DIARY RANGE 

You need to edit the CleverPsych.cmd (above) file. We use one hour appointments 

between 9am and 6pm and use a diary the shows those hours with half hour 

increments. 

You can set up your own diary e.g. if you work 9 to 5 and have random appointment 

times that start on the quarter of an hour: 

set STARTHOUR=9 

set ENDHOUR=18 

set MINUTES=15 

 

Be careful with the interval, which can be 10, 15, 20, 30 or 60 minutes e.g. if you start 

with 20 minutes and later decide to change to 30 minutes the system has no way of handling 

old appointment times. Similarly don’t reduce the hour range to one that does not include old 

appointment times. 

16.3.3 CONFIGURING THE LOOK & FEEL 

CleverPsych usually uses a standard set of colours. We recommend that you use them. 

However, if you are using CleverPsych for several psychologists on the same 

computer you may wish to use different colours for each. 

Java comes with several look and feels (L&F, LAF).  Edit t5he start script and choose 

one.  

You can use different colours by using the NimROD look and feel and loading 

different colour themes, which are files in the CleverData\config folder. 

e.g. edit the script to set the value 

set LAF=LightTabaco.theme 

Google for “NimROD laf” for further information. 
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16.3.4 DEFINING LOOK AND FEEL THEMES 

You can use the NimROD gui to define your own themes or modify existing ones. To 

run it double-click the NimROD.cmd file in the CleverPsych\scripts folder. 

             

The procedure is: 

On the Config tab: 

• Optionally Open an existing theme file from CleverData\config 

• Click on the squares and set colurs from the colour dialog. 

• Set how opaque menus and frames are with the sliders (probably use fully on). 

• Hit the Test button to apply the colours – you must do this. 

• Look at the other tabs to see the effects. 
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• Save to a theme file 

• Set the script parameter as above to the theme file and run CleverPsych to try 

it out. 

 

            A Swing theme is defined by eight colours, although only four are  

            used in the wild: 

              Black, for texts  

              White, for texts fields background  

              Background, the background colour of almost everything.  

              Selection, the colour for focused controls  

            "Selection" and "Background" groups have four squares, and one is  

            slightly separated, because although Swing uses three colours for  

            each category, those three colours must be coordinated, so they must  

            by the same colour, but more dark. For example, if we want a grey  

            background, the first square will be "our" grey, the second will be  

            lighter and the third will be even lighter. 

            You can define the squares one by one, but if you define the  

            separated square, the three colours will be automaticaly set. 

            When you have chosen your favorite colours, click "Test" button and  

            see the results in the tabs. 
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17.0  DOCUMENT TEMPLATES 

You can generate various documents where client, appointment and referrer details are 

automatically filled in. Several templates are supplied, and you can modify these and add 

your own. Supplied templates include: 

• Letters to referring doctors 

• Invoices 

• Client and appointment notes 

• Assessment and report sample 

• Example showing what is available 

 

 

Document templates are defined as Rich Test Format (RTF) files in the Templates directory. 

 

TemplatesDir.png 
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Templates are set up with known strings that are replaced with actual values from the 

current client and appointment. 

This does not work with the Word binary formats such as doc. We use the RTF 

format which is a plain txt file (you can read it in WordPad). 

RTF files with embedded images (e.g. your logo) can be large. 

17.1 Example 

To repeat an earlier example; the following letter was generated by selecting Daisy 

Duck’s first appointment and the selecting “Referrer acknowledgement” from the Office 

menu. 
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This was generated from the following template file: 
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As you can see, the template has some obvious values such as 

APPOINTMENT_DATE and CLIENT_FULL_NAME. 

Documents are usually generated in the client’s directory and you will often modify 

them and save then before sending them off. 

17.2 Configuration 

The main configuration file contains some information about the psychologist i.e. you. 

The supplied letters use this information, mainly to make it easier to configure for 

multiple psychologists. 

You should set up the values: 



 74 

Psych First Name=Crazy 

Psych Full Name=Dr Crazy Horse 

Psych Mobile=04123456 

Psych Mail=crazy@gmail.xyz 

Psych Phone=98765432 

Psych Fax=12344321 

17.3 Supplied Documents 

You will likely want to use some of the supplied letters, so the first thing would be to 

load them into your word processor and insert your usual letter header and signature blocks. 

There is also a “one off” menu item. If you want to create a non-standard letter you can edit 

the OneOffLetter.rtf template and select the menu item to generate the letter. 

17.4 Your Documents 

To generate your own letters etc start with one of the supplied templates, modify it 

and save it as a new RTF file in the templates directory. 

We have had problems doing this with word. You may have to set up a basic RTF file 

with your header that works and copy and paste to it to set up all the files. 

There is an example template which contains all the available strings (we use it for 

development and testing). You can display it as a letter in the usual way. Here is some of it. 
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. 

You can copy-and-paste from the Example.rtf file into your document. We 

recommend this as you need to have the spelling and case exactly right. Sometimes word 

doesn’t handle this. 

 

When you have defined your new letter you have to tell CleverPsych about it and 

insert it into the Office menu. You do this by editing the main configuration file. For 

example, here are some lines from the file: 

Word extension=.rtf 

Invoice / receipt=templates\InvoiceReceipt.rtf, Anonymous 

Client notes=templates\Notes.rtf, OneOnly 

Referrer acknowledgement=templates\ReferAck.rtf, DateReqd 

Mid referral=templates\MidReferral.rtf, DateReqd 

End referral=templates\EndReferral.rtf, DateReqd 

Example=templates\Example.rtf 

 

The first line “Word extension=.rtf” tells the system that we are using RTF files. If, 

for example, you were using OpenOffice, you might decide to use another type of file. 

Actually not used! 
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The other lines define the Office menu items: 

▪ The part before the = is the menu item. 

▪ The next part is the file name (starting with templates) 

There may be comma separated flags following: 

▪ OneOnly means that there is only one file created for the letter for that client, 

and each time the file will be re-opened. 

▪ DateReqd means that the file name will contain todays date so you know from 

the directory when you wrote it. 

▪ Anonymous means that the output file is not stored for the user (its written 

into the tmp folder). 

The OneOnly flag is used with the Notes letter type which is a place for you to store 

whatever you want to write about the client. 

 

17.5 Rich Text Problems 

Sometimes you will find that whatever you do you cannot get a known text string to 

be replaced. This is because the actual RTF file does not have the complete text string. 

You can fix the template by opening it in NotePad. 

For example the following was in a template that would not display the client Email 

address: 

 

\par \tab \hich\af2\dbch\af31505\loch\f2     

 Email: CLIENT_EM\hich\af2\dbch\af31505\loch\f2 AIL 
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The template had to have the rubbish removed so the correct string is there i.e. 

Email: CLIENT_EMAIL 
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18.0  SMS AND MAIL 

18.1 Introduction 

CleverPsych can send mail, and can send SMS messages by mailing them to a provider. So 

you need to configure both mail and SMS. 

18.2 Configuring mail. 

To enable mail you need to edit the configuration file so you have lines like the 

following: 

Mail user=cleverpsych@bigpond.com  - you Email address i.e. your account 

Mail password=crazy – your account password 

Mail host=mail.bigpond.com – your mail provider’s server 

Mail port=25 

 

Most of the parameters are the same as you have put into outlook to define your Email 

account. 

You can also use a Gmail account by using lines like: 

Mail user=cleverpsych@gmail.com 

Mail password=HaHa%^& 

Mail host=smtp.gmail.com 

Mail port=465 

 

You have to ensure the POP is enabled in your Gmail account 

• Log into your Gmail account 

mailto:user=cleverpsych@bigpond.com
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• Go to the Gmail settings 

• Choose Forwarding and POP / IMAP 

• Chooses enable POP (if is not set already) 

 

Check that you have configured mail correctly by using a mail option from the Mail 

& SMS menu. 

18.3 SMS Providers 

You can send SMS messages from CleverPsych by using a provider. 

Several companies can be found on the net and you can open an account with one of them. 

To send an SMS message you send an Email to the provider. For example to SMS a 

client with mobile phone number 04123456 you simply Email the message to 

04123456@provider.com where provider.com is the providers Email address. 

Messages cost 5 to 25 cents. 

You need a provider that works in the above way.  

mailto:04123456@provider.com


 80 

You open an account using the Email address that you have configured. 

There are usually some providers that can be enabled and used defined in the main 

configuration file. Check their web sites for details. 

18.4 Reminders 

A large number of our clients do not show up for their appointments, so we send them 

a reminder, usually the night before. For problem clients, you can send a second reminder an 

hour or so before the appointment. 

Reminders are automatically send in the evening or in the morning. When they are 

sent is defined in the main configuration file, and can be disabled there if not required. 

Use the “Mail & SMS -> Remind” menu items to manually send reminders. 

The system will remind the client via SMS if they have a mobile phone number, and 

fall back to any entered Email address if they don’t. 

You only need to have the occasional client turn up when they would have forgotten 

to pay for it. 

The text of the message is defined in the templates\Reminder.txt file: 

Your next appointment with Fred is on APPOINTMENT_DAY 

APPOINTMENT_DATE at APPOINTMENT_TIME.  

 

Please reply if you cannot attend or call Fred on 04 123 456. 

It would be a good idea for you to edit this file before use. 

We also have some clients who regularly respond to the reminder but still do not turn 

up. Sometimes this can be solved by making sure they have appointments later in the day. 
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You can also set a flag against the client so they are sent an extra reminder just before the 

appointment. The number of hours before is a configuration item: 

# Send extra emails to clients who often do not attend 

# This is number of hours before their appointment 

Extra reminder hours=1 

 

You can also send an extra reminder from the SMS menu. 

There is also a template file C:\CleverData\templates\ReminderExtra.txt that you 

should edit. 

 

18.5 Missed appointments 

You can send a message to a client who did not turn up by selecting the missed 

appointment and using the “Mail & SMS -> Missed appointment” menu item. 

The text of the message is in the MissedAppointment.txt template file. 

 

18.6 Sending SMS 

You can send a message to a selected client or to all clients (after filtering). 

For us older people who have trouble using their thumb to input messages there is 

also a menu option that enables you to type in a message (max 160 characters) and send it. 

This pops up a dialog for you to use: 
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SMSdialog.png 

You can also set up a list of recipients to appear in the dialog by using the “Config-

>Edit SMS list” menu item. Follow the format below. 

 

ConfigSMS.png 

 

18.7 Sending Mail 

You can send mail by using similar menu items to those above for SMS. 
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ConfigMail.png 

 

18.8 Work Lists 

You can have a list of client appointments and services sent to you the night before or 

in the morning (so you know if you have to get out of bed). 

The list can be sent automatically by mail and / or SMS. You can also send it from the 

Mail & SMS menu. 

Automatic sending (if you are connected permanently to the internet) is defined in the 

main configuration file: 

# Sending list of today's appointments and services 

# nothing is sent if there are no appointments or services 

# hour is the morning if in range 6 to 10 

# or the evening before if 1700 to 2200 

Appointments list time=0 

# will send to this Email if given 

Appointments mail=crazy@gmail.xxx 

# will send SMS (short list) if mobile is given 

Appointments mobile=041234567 

18.9 Mail Problems 

If mail is not being sent check the black background screen for errors. The likely 

problem is that you are not connecting to the mail server. Obvious errors are in the 

configuration where you do not have the correct mail server, Email address or password. 
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Failure to connect can also be caused by a Firewall or Anti-virus setting. For example, 

if you use Norton Internet Security you may have to go into Network settings -> Configure 

and turn off “Scan outgoing Email messages”. 
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19.0  MEDICARE AUSTRALIA 

19.1 Overview 

CleverPsych has an optional add-on that provides support for bulk-billing 

MEDICARE Australia. Claims can be sent to MEDICARE for processing and 

payment into your bank account. 

Claims can also be sent on a clients behalf where they pay you and later claim 

a refund from MEDICARE. 

19.2 Hiding Australian Features 

CleverPsych has been written to be general purpose as far as possible, but 

some Australian specific features have crept in; specifically support for bulk-

billing MEDICARE Australia. 

If you are not in Australia you can hide all the Australian features by editing 

the main configuration file (from the Config menu) and setting the line: 

Hide Australian=true 

 

19.3 MEDICARE Australia Bulk Billing 
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CleverPsych can send bulk billing transactions to MEDICARE which are 

processed a few days later and your bank account credited. 

Initial setting up is painful, but once it is done is much easier that the paper 

form procedure. 

 

You need to access www.medicareaustralia.gov.au to register with MEDICARE. 

This takes some time. You are required to set up your sites to do business online through the 

eBusiness team. Further information on this process can be found at  

http://www.humanservices.gov.au/health-professionals/subjects/doing-business-online-

for-health-professionals 

 You can download all the forms from the MEDICARE site. 

19.3.1 PROVIDER NUMBER 

You need a provider number before you can do anything with MEDICARE. Look in 

the Allied Health Professionals section of the MEDICARE site. 

 You probably already have one, otherwise find the link to Application for an initial 

Medicare provider / registration number for an Allied Health Professional form 

(HW063), print the form, fill it out and send it off. 

When you have a provider number edit the configuration file and insert it (and enable 

Australian features as above). When you restart CleverPsych all the MEDICARE 

features will appear. 

19.3.2 PREPARATION 

You should make sure that your database is correct. You can filter on all your bulk-bill 

clients and produce a validation report (and copy it into word while you correct the database): 

http://www.medicareaustralia.gov.au/
http://www.humanservices.gov.au/health-professionals/subjects/doing-business-online-for-health-professionals
http://www.humanservices.gov.au/health-professionals/subjects/doing-business-online-for-health-professionals
http://www.humanservices.gov.au/health-professionals/forms/hw063
http://www.humanservices.gov.au/health-professionals/forms/hw063
http://www.humanservices.gov.au/health-professionals/forms/hw063
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Each referring doctor must have their provider number recorded. If they have multiple 

provider numbers insert a new referrer record for each number. 

You should fix your clients so they have the correct type i.e. bulk bill where required. 

Check that your appointments have the correct status (cancelled, paid, or to be 

claimed etc). 

 

19.3.3 SITE CERTIFICATE 

When you have a provider number you can apply for a site certificate to use the 

Medicare software. See the Medicare “Public Key Infrastructure” page. 

Apply for a Medicare PKI site certificate using the following forms: 

• Application for a Public Key Infrastructure Site Certificate (HW001) 

• Acceptable Referee Declaration for Public Key Infrastructure Certificate applications 

(HW004) 

While you are at it, you should also apply for an individual certificate, so you can use 

HPOS. See below. 

On the forms put the Conformant software details as: 

• Software product name:  CleverPsych 

• Software product version:  10.1 

You will receive a DVD from MEDICARE with your certificates on it, and the 

certificate passwords. Here is an example: 

 

http://www.humanservices.gov.au/health-professionals/forms/hw001
http://www.humanservices.gov.au/health-professionals/forms/hw004
http://www.humanservices.gov.au/health-professionals/forms/hw004
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If you have already obtained a site certificate and they have almost expired, you can 

ask for a replacement DVD by using the form: 

Request to Revoke or Reissue a Public Key Infrastructure Certificate (HW003) 

19.4 CleverPsych MEDICARE Installation 

When your purchase the MEDICARE extension we will send you a DVD. 

MEDICARE will not allow us to make the files available for download. 

The DVD has the following on it: 

 

All you need to do is copy the CleverDataMEDICARE2015 folder to: 

• The C: drive on windows, or 

• Your home directory on Mac, Linux etc 

 

http://www.humanservices.gov.au/health-professionals/forms/hw003
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19.5 INSTALL SITE CERTIFICATES 

You need to run (double click) a CleverPsychSiteCertificates script to install your 

certificates off the MEDICARE DVD into your CleverData folder.  Use the appropriate script 

in the CleverPsych\Scripts  folder for windows or Mac. 

 

19.5.1 WINDOWS CERTIFICATES 

First put the MEDICARE site certificates dvd into the drive. Then run the 

CleverPsychSiteCertificatesWIN.cmd script file. 

You need to type in the PIC sent to you as a letter by medicare, and give your 

password for the generated Java key store. Note that nothing appears as you type in a 

password (followed by enter). 

The following are the main parts of the output: 

Put your site certificates DVD into the drive 

 

Enter DVD drive ( e.g. D: ): E: 

 

 Directory of E:\ 

 

01/10/2015  10:57 AM             5,801 fac_encrypt.p12 

01/10/2015  10:57 AM             5,801 fac_sign.p12 

04/04/2014  10:56 AM             1,597 hic_encrypt.crt 

04/04/2014  10:56 AM             1,597 hic_sign.crt 

18/04/2011  04:55 PM               141 master.css 
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27/08/2014  12:14 PM             1,611 mca_encrypt.crt 

27/08/2014  12:14 PM             1,611 mca_sign.crt 

01/10/2015  12:49 PM    <DIR>          PKI_Certificate_Manager_Installer_Windows-

V2.3.20 

05/11/2014  09:44 AM            70,983 readme.html 

01/10/2015  12:49 PM    <DIR>          readme_files 

15/10/2014  10:14 AM             2,971 Trust.p12 

               9 File(s)         92,113 bytes 

               2 Dir(s)               0 bytes free 

 

You should have 2 certificates in C:\CleverMEDICARE2015\certificates 

 

 Directory of C:\CleverMEDICARE2015\certificates 

 

06/07/2016  03:31 PM    <DIR>          . 

06/07/2016  03:31 PM    <DIR>          .. 

01/10/2015  10:57 AM             5,801 fac_encrypt.p12 

01/10/2015  10:57 AM             5,801 fac_sign.p12 

               2 File(s)         11,602 bytes 

               2 Dir(s)  845,228,834,816 bytes free 

 

Put certificates into Java Key Store 

You need to have the medicare supplied site certificates password, and 

Give a 6 character store password that you enter later into the Australia menu 

 

The MEDICARE program is executed to create the certificates store 

 

PsiMigrationProgram v.1.1.8 

Enter password of P12 files in the directory. All P12 files must have this same 

password: 

Enter password of target JKS store: 

Re-enter password of JKS target store: 

********************************************************* 

Target JKS is saved to C:\CleverData\medicare\hic.jks 

********************************************************* 

19.5.2 MAC CERTIFICATES 

First copy the CleverMEDICARE2015 directory off the DVD to your home directory. 
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Copy two of your certificates from the site certificates DVD to 

CleverMEDICARE2015/certificates 

 

Ending up with: 
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Run the CleverPsychSiteCertificatesMAC.command script from  

 CleverPsych/Scripts i.e. search for CleverPsychSiteCertificatesMAC.command in the 

finder and double click it. It needs to run in a terminal, so the following may appear:  

 

 

You need to type in the PIC sent to you as a letter by medicare, and give a password 

for the generated Java key store. Note that nothing appears as you type in each password 

(followed by return). 

You should get a listing of 9 entries in the store: 
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The script will also update the Java security policy files in 

$HOME/JRE1.7.0_51/lib/security, which is required. 
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19.6 CleverPsych Configuration 

 

19.6.1 DB4 TEMPLATE 

Edit the DB4.rtf file in your CleverData/templates folder, and set details for 

your practice. 

19.6.2 CLIENT TYPE LIST 

The client type configuration file  has to have entries for the medicare claim types.  

Medicare cash 

Medicare bulk bill 

Medicare PDVC 

These will normally be there, unless you are using an old version of CleverPsych. The file 

can be edited from the Config menu. 

 

19.6.3 SERVICE NUMBERS 

You also need to set the service numbers list. You can do this from the Config 

menu or can directly edit C:\CleverData\config\ServiceNumberList.txt file 

with NotePad. 

The software will process claims for services that are considered by 

MEDICARE to be specialist services. These are often 80000 numbers. 

The file provided in the CleverDemo folder looks something like: 

80010 MEDICARE Clinical Psych - in rooms - (50+ min) 

80015 MEDICARE Clinical Psy - out of rooms - (50+ min) 

80000 MEDICARE Clinical Psych in rooms - (30-50 min) 

80005 MEDICARE Clinical Psych - out of rooms - (30-50 min) 

80020 MEDICARE Clinical Psych -  Group Session - (60+ min) 
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80100 MEDICARE FPS Service - in rooms - (20-50 min) 

80105 MEDICARE FPS Service - out of rooms - (20-50 min) 

80110 MEDICARE FPS Service - in rooms - (50+ min) 

80115 MEDICARE  FPS Service - out of rooms - (50+ min) 

80120 MEDICARE General Psych - Group Session - (60+ min) 

N0104 NRMA Initial visit 

N0124 NRMA follow-up 

80110 MEDICARE Consultation 

80115 MEDICARE Home visit 

 

Psychologists will probably use either 80010 or 80110. 

You should add the lines you need. If you already have an entry you should 

leave that there as it has been used. Put the default entry at the top of the file. 

When you have done this edit the main configuration file to set the current 

rates 

 

# Appointment service code fee lookups 

# These appear as first word in service number list config file 

80010=119.80 

80015=140.15 

80000=81.60 

80005=102.00 

80100=57.80 

80105=78.65 

80110=81.60 

80115=102.50 

N0124=250.00 

19.6.4 MAIN CONFIGURATION 

You need to edit the main configuration file from the Config menu and fill in 

the MEDICARE bulk billing details. The file has comments telling you what 

to set. 

# ================== Australian stuff================ 

# You can turn off all the Australian stuff by setting this to true 

Hide Australian=false 

 

# Australian MEDICARE bulk claiming - see the manual 

# 
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# You need to be a registered user and have purchased the medicare 

# extension software to use the medicare bulk billing. 

# 

# Servicing provider number. If not given no medicare menus etc will 

# appear in the window (they will in the demo version) 

MEDICARE Servicing Provider Number= 

# 

# If the psych who provided the service is not the person paid 

# you need to give the payee name and number 

MEDICARE Payee Provider Name= 

MEDICARE Payee Provider Number= 

# MEDICARE Payee Provider Name=Dr Super Man 

# MEDICARE Payee Provider Number=1234567X 

Bulk bill requests are run overnight. If you leave your computer running all the time 

with the Internet connected you can set the hour when your claims are to be sent and when 

the processing is to be checked the next day. 

# 

# Time to automatically send all bulk bill request to MEDICARE (hour) e.g. 23 

# zero if not required. 

MEDICARE Send=0 

# Time to get previous nights processing results e.g. 7 

# zero if not required. 

MEDICARE Fetch=0 

 

You also need to define default values for the medicare client types: 

 

Medicare cash_FEE=180 

Medicare cash_TAX=0 

Medicare cash_SESSIONS=12 

Medicare cash_CLAIM=0 

Medicare cash_CHECK=RefNo,Referrer,DOB,Service 

 

Medicare bulk bill_FEE=124.5 

Medicare bulk bill_TAX=0 

Medicare bulk bill_SESSIONS=0 

Medicare bulk bill_CLAIM=30 

Medicare bulk bill_CHECK=RefNo,Referrer,DOB,Service 

 

Medicare PDVC_FEE=140 

Medicare PDVC_TAX=0 

Medicare PDVC_SESSIONS=12 

Medicare PDVC_CLAIM=0 

Medicare PDVC_CHECK=RefNo,Referrer,DOB,Service 
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19.6.5 MEDICARE LOGS  

The CleverMEDICARE folder contains a file log4J.properties that controls the output 

of logs from the MEDICARE supplied software. You usually do not need to touch this, but it 

does output logs into C:/CleverMEDICARE/logs/easyclaim.log on windows or 

/tmp/logs/easyclaim.log on Mac and linux.  

If you are running multiple versions (i.e. are using data folders other than CleverData) 

you might want to put the logs somewhere else. 

These logs can be used to diagnose serious problems. 

You can access the medicare software log from the Australia menu. 

 

 

 

19.6.6 MEDICARE SOFTWARE FILES 
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The MEDICARE supplied software uses a .medicareonline folder in your home 

directory e.g. on windows C:\Users\lloyd\.medicareonline. 

19.6.7 LOCATION ID 

When you have configured CleverPsych (and entered your provider number) 

you can start it up, and a Location ID will be displayed in the screen title. The 

ID is of form TCC12345. 

You have to advise MEDICARE of this location ID by downloading and 

sending an Online Claiming Provider Agreement form (HW027) 

before you can use CleverPsych bulk billing. 

You provide other information on the form about your practice and bank 

account. Make sure you set the type of online transactions to “Medicare bulk 

bill”. 

19.7 Getting Started With MEDICARE 

After configuration, you will have an Australia Menu which has items you use 

to talk to MEDICARE. 

19.7.1 CERTIFICATE PASSWORD 

Select the Certificate Password menu item and input the password you 

used when you defined your certificate store. This enables the 

CleverPsych software to connect to the MEDICARE server. 

19.7.2 CLIENT CHECKING 

http://www.humanservices.gov.au/health-professionals/forms/hw027
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When you enter a new client or modify and existing Bulk Bill client various 

fields are checked: 

• Enter client names with their initial; MEDICARE requires this for the 

DB4 form (see below). 

• Clients are of type “Medicare bulk bill”. 

• The client medicare number is entered in the Reference field in the 

form <medicare number>/<reference number> e.g. 4950080191/2. The 

reference number is the single digit “within family” number. 

• The referring doctor must be specified, and he must have a provider 

number recorded. 

• The client’s birthday is required. 

• Appointments must have a MEDICARE service code (see configuring 

the service numbers list above). 

 

19.8 Basic Bulk Billing Procedure 
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To try Bulk Billing for the first time, select a Bulk Billing client and 

click modify to check that the client fields are OK. Then choose an 

appointment that you need to claim for and once again click modify to 

check that the appointment is OK. 

The basic claiming procedure is: 

• When the client has attended the “Bulk Bill” button is clicked, which 

causes a DB4 form to be displayed. You need to print it, get the client 

to sign it, and give it to the client to take away. (You used to have to 

file a copy of the DB4, but that is no longer required as long as you 

have a record of attendance as in CleverPsych). 

• The appointment status will change to “To be claimed”. 

 

 

Appointments at this stage are ready to be claimed. You need to send them to 

MEDICARE. 

• Connect to the Internet 
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• Select the Australia-> Claim from MEDICARE menu item. 

• The status of all appointments to be claimed will change to “Claimed”. 

• If there are problems you can look at the latest log file in the 

CleverData/logs folder (names of form MEDICARE_ALL…). 

• You can configure the system to have this happen automatically. 

The next day you check that the claims have been processed (usually the next 

day): 

• Connect to the Internet 

• Select the Australia-> Get MEDICARE report menu item. 

• The status of all appointments to be claimed will change to “Paid to 

bank” or Rejected. 

• If there are problems you can look at the latest log file in the 

CleverData/logs folder (names of form MEDICARE_REPORT…). 

• You can configure the system to have this happen automatically. 

You can check the colours of entries in the diary to find claims that had some 

problem. 

NOTE that it can take about 4 days for claims to be processed. 

You will have reports appear: 
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19.9 Serious MEDICARE Bulk Billing 

When you have many MEDICARE bulk billing clients, this is how you can 

handle the claims: 

19.9.1 DB4 

At the start of each day (or the night before)  select “Prepare DB4s” from the 

Australia menu. 

This will display each DB4 in turn in your word processor, and you print 

them. 

When each client arrives they need to sign their DB4 and take it away. 
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19.9.2 APPOINTMENT STATUS 

After each client has attended you set their status to “To be claimed”. If they 

did not arrive set it to the appropriate status. 

 

19.9.3 CLAIMING 

At a convenient time, connect to the internet and select the “Claim from 

MEDICARE” item from the Australia menu. This will send all claims and 

display a report. 

Select the “Get MEDICARE report” to retrieve a report showing the status of 

all outstanding claims. 

Any appointments with problems will display a medicare message and will 

have a status of rejected. You need to find out what is wrong, correct the data, 

and reset the status to “To be claimed”. 

19.9.4 AUTOMATIC BULK BILL CLAIMING 

If you are permanently connected to the internet you can send and receive 

claims automatically by setting the configuration: 

# Time to send all bulk bill request to MEDICARE (hour) 

MEDICARE Send=22 

# Hour to get bulk bill processing results 

MEDICARE Fetch=7 

# MEDICARE takes a few days to process claims, give number of days 

# before try and retrieve a claim report (0-5) 
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MEDICARE Wait=1 

 

Make sure that you have set the power options from the control panel so that 

your system keeps running. See chapter 2, Configuring Windows. 

19.10 Logs 

When you send claims to medicare or generate a report of the processing, logs 

are produced and stored into CleverData\logs. 

 

The report is displayed if you send claims or ask for a report from the 

Australia menu. You can also display the latest logs from the menu. 

Older logs are available as above. 

19.11 Client Refund Claims 
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A client of type “MEDICARE CASH” has a MEDICARE referral and will 

normally pay you and then take the receipt to MEDICARE for the refund or 

claim on the MEDICARE web site. 

 

You can use items from the Australian menu and fields in the client tab to 

submit a claim on the client’s behalf. 

 

19.11.1 STANDARD CLAIM 

When a client of type “Medicare cash” attends an appointment and pays you, 

you set the appointment status to one of the paid statuses. 

You can then select “Send client claim to MEDICARE” from the Australia 

menu, which will send a claim to MEDICARE on their behalf. 

Payment is by EFT only to the claimant's bank account details stored with 

Medicare. If the claimant does not have bank account details stored with 

Medicare, they will need to register these in order to receive payment. 

A statement will be displayed that you can print for the client. This is either a 

“Statement of Claim Benefit Paid” if the claim was successful or a 

“Lodgement Advice” if the claim will be verified by MEDICARE before 

payment. 

An error message will be displayed if the claim is not paid. 

19.11.2 OTHER CLAIMANT 

Sometimes the claim is paid to someone else e.g. a child’s parent. 
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In this case you need to enter and store the claimants name and MEDICARE 

number in the fields in the client tab. 

19.11.3 PDVC CHEQUES 

Some health professional are eligible for the 90 day pay doctor cheque scheme. This 

is usually medical practitioners, but not allied health professionals.  

Clients must be type “Medicare PDVC”. This must be in the client type list 

configuration file. 

When a patient’s unpaid or partially paid medical account is lodged for payment, 

MEDICARE will send the patient a Pay Doctor Via Claimant (PDVC) cheque. The patient is 

required to give the cheque to you for payment. 

Benefit payment is directed to the provider (for partially Paid or Unpaid accounts) 

Payment is by cheque made out to the provider but sent to the claimant using the 

address details stored with Medicare or temporary address specified in the Client tab. 

19.11.4 BANK ACCOUNT 

Temporary Bank Account Details can be specified in the client tab. Supplied using 

data elements:  

• BSBCode,  

• BankAccountNum 

• BankAccountName 

If supplied, for that claim only, payment is by EFT to the bank account details supplied in the 

claim rather than those stored with Medicare. The bank account details are not stored. 

19.11.5 TEMPORARY ADDRESS 
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Temporary Address Details can be supplied using data elements:  

• ClaimantAddressLine1 

• ClaimantAddressLine2 

• ClaimantAddressLocality (valid name for postcode e.g. Canberra for 2601) 

• ClaimantAddressPostcode   

If supplied, these details will only be used to direct correspondence regarding the 

claim or a Pay-Doctor-Via-Claimant cheque if either are required. They will not be used to 

send claimant cheques as these will no longer be issued after 30 June 2016. 

19.11.6 CANCEL CLAIMS 

Claims are actually processed over night, and can be cancelled if a mistake is made (from the 

Australia menu) if done before the end of the day. 

19.12 Medicare Payment 

As we understand it the payment procedure is: 

• Medicare claim payments are sent to the Reserve Bank every morning 

• The Reserve bank sends out the payments to banks over-night, but not on weekends. 

• Your bank will probably process the payments into your account the next night 

So, it can take  a few days for a claim to appear in your account. 

Occasionally payments do not seem to be processed. You can always set appointment status 

to to-be claimed and send bulk bill claims through again. Medicare will not pay them twice. 

19.13 Processing problems 
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The software supplied by MEDICARE writes a software (Log4J) file that can be accessed 

from the Australia menu. The medicare error codes are often of little use, but the log can 

help. 

If claims fail without any apparent reason, you can try deleting files from the .medicareonline 

folder in your home directory e.g. on windows C:\Users\lloyd\.medicareonline, on unix 

clones /usr/home/.medicareonline. Clims will then have to be re-submitted. 

To send claims again, set the appointment status to “to be claimed”. 

19.14 HPOS 

Health Professionals Online Services (HPOS) is an on-line way to access 

medicare services from your browser. 

Starting 

You need to apply for an individual certificate (see above). Medicare will send 

you a DVD of software, a USB dongle and a password in a separate mail-out. 

There are instructions provides and on the medicate web site, but you need to: 

Install the software off DVD. 

1. Put chip into dongle and insert into your computer. 

2. Download 3 certificates and double click them to install into your 

browser. 

3. Log into HPOS from your browser using the password you were sent. 

4. Probably set your password (after which you may have to re-install the 

certificates. 
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This is the main screen. You will not use much of it, but you can do a few 

things as follows. You can set your bank account too. 

 

  

One useful facility is to be able to look up a client’s medicare number if they 

attended and then disappeared without supplying their number. You can copy 

and paste the name from CleverPsych. 
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There are other facilities that might be useful, e.g. 

 

 

 

 



 111 

20.0  AUSTRALIA SECURE 

MESSAGING 

20.1 Overview 

CleverPsych has been extended so you can send and receive secure messages 

via HealthLink. 

This software means that you can send reports to referring doctors and receive 

client referrals and notes. 

The doctors have to use practice management software that has access to 

HealthLink too. 

We found that our doctors did not use HealthLink to send us referrals, so we 

do not use it. 

 

20.2 HealthLink 

For information about HealthLink go to  www.HealthLink.net. 

You will need to register with HealthLink and install their software. They 

have a help line that you can call for assistance. 

We believe that it costs about $1 / day. 

You can configure the software to send and receive periodically or on demand. 

http://www.healthlink.net/
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Obviously you need to connect to the Internet. 

Make sure that you use the default HealthLink folder C:\HLINK, which is 

where messages are send from and received into. 

HealthLink will probably let you try out their software. The first thing you can 

do is set up a test client with test referring doctor, both with your identifier 

(EDI) and send a test report i.e. send it to yourself. 

 

20.3 Sending Reports 

You need to prepare your report first. You can do this from the Office menu or 

external to CleverPsych. The report will normally go into the 

CleverData\clients folder. 

You can then send the report by 

• Choosing the client from the tree. 

• Selecting the Send Report item from the Australia menu. 

• Open the report to send. 

• Check the displayed log for errors. 

Some important considerations are: 

• Sending and receiving depends on the capabilities of the doctor’s 

software.  

• Text reports are the only formats that are always supported. 

• RTF files (as used by CleverPsych) are supposed to be supported but 

apparently many software packages do their own handling of RTF 

files, and don’t do it very well. You need to check with your doctor 
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and perhaps send some sample reports. The problem apparently is with 

handling of fonts, so it may not matter much. 

• Some packages can receive and send PDF files. 

• There are limits on the size of files that can be transferred e.g. if you 

have your logo in an RTF format report the file is probably too big. 

20.4 Receiving Messages 

You can use the Australia Menu item to load any messages that have arrived 

into CleverPsych. 

Files are automatically put into the clients area if details match those stored in 

CleverPsych. 

20.5 CleverPsych Tabs 

The HealthLink tab displays messages (reports) that have been sent and 

received. There are also Acknowledgement messages. 
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If you select a message , its contents are displayed in the Secure Messages tab 

at the bottom, and you can use the buttons to: 

• Add a new client to the database. 

• Add a new referring doctor to the database. 

• Assign a report to a client (if the details don’t exactly match). 

• Delete a message record. 

20.6 Logs 

Logs are displayed when you receive or send messages. 

You can also retrieve logs for display by using the Australia menu. 
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20.7 Configuration 

You need to edit the main configuration file and set values for HealthLink. 

 

You need to turn on the Australian menu. 

Hide Australian=false 

Then put in the details from your HealthLink registration i.e. the identifier 

(EDI) and the Name you provided. 

HealthLinkIdent=MYEDI 

HealthLinkName=My Business 
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You also need to provide some more information about yourself that 

HealthLink requires, for example: 

Psych Provider Number=1234567A 

Psych Surname=Horse 

Psych Title=Dr 

Psych Address=123 Main Street, Hicksville, New York. 

20.8 Other Considerations 

HealthLink wants a full phone number, so you need to put an area code at the 

front of all phone numbers (except mobiles which already start with zero) as 

e.g. 01 2345 678 

The client medicare number is used for matching messages and clients. 

Referrers need to have their HealthLink identifier recorded. You can look this 

up with the HealthLink software. 

 

20.9 HealthLink Icons 

After installing HealthLink you will have some icons on your desk top and 

some entries in the start menu: 
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20.10 Doctor Identifiers 

You can run HealthLink User Online and select “Site” to display the EDI Site 

Listings. 

Search for your city to find the local medical practices. 

You can then set the EDI identifiers in your referrers so you can send 

messages to them. 
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HealthLink Logs 

You can click the HMS Event Log icon to see the logs generated by the 

HealthLink software when it sends and receives messages. 
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20.11 HealthLink Configuration 

You set up HealthLink using the HMS Advanced Options from the Start-

>Healthlink menu items. 

We suggest you phone the HealthLink Help line for assistance. 

For example, you can schedule the HealthLink software running on your 

computer. 
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21.0  DISASTERS 

21.1 Command Window 

As previously described, the command window will print out error messages if there 

are problems with your system. If you are extremely lucky, they may make sense to you. You 

can mail the contents to us, and if you are luckier still, the messages may make sense to us. 

21.2 New Computers 

If you have bought a new computer you should download the latest version of Java 

(from Oracle). 

Make sure that the time zone is set correctly (click on the time). 

21.3 New Word Processor 

If you have bought a new version of Microsoft Office (or other) and selecting an item 

from the Office menu does not display a letter you need to update your 

CleverData\config\WordProcessor.txt file to give the executeable file. Look first at the latest 

CleverDemo\config\WordProcessor.txt file. 

21.4 Memory 
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If you are handling a larger number of clients you may exceed the maximum allocated 

memory. There will be a message in the command window of the form: 

java.lang.OutOfMemoryError: Java heap space 

The memory can be increased with the Xmx parameter on the run command in the 

scripts\CleverPsych.cmd file e.g. 

java -Xmx512m -classpath %CLASSPATH% psycho.Gui %DATA% 

%SOFTWARE% %DATABASE% %TITLE% 

You will need to add the parameter or increase the value e.g. to –Xmx1000m 

There is a maximum value that you can set, usually about 1500m. 

21.5 Database Recovery 

It is possible that some windows problem could result in a corrupted database with the 

resulting loss of client data. We have seen this happen when a fan failed in summer and the 

computer overheated, and when the windows system strangely “hung”. 

This should not be too serious as you have been regularly backing up your system, 

haven’t you? 

To restore a database you need to replace the existing Database.xml file in the 

database directory with a backup copy, restart CleverPsych, and then manually re-enter recent 

appointments from your paper diary. There are usually many backup copies on the database 

in the CleverData\backup folder – use the one with yesterdays date. 

The database file Database.xml will probably appear in windows explorer as a file 

called Database of type XML. 
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If you think that there is a problem with your disk, don’t delete the old database file 

but rename it which may stop the bad part of the disk being reused, and talk to your computer 

service person. 

Every time you start CleverPsych a backup of your database is stored in the backups 

directory (and typically kept for a month). You can usually find a backup that is more recent 

than the one you made yourself. 
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In summary: 

• Click on the latest database backup and copy it. 

• Go to the database folder and paste 

• Rename the existing database file e.g. to BADdatabase.xml 

• Rename the backup file to Database.xml 

 

A trap is that the latest backup may have been made of a corrupted database so is also 

corrupted – you will have to use an older backup. 

21.6 Java Problems 

We have seen a case where some Java files were strangely deleted. If you see 

messages that seem to relate to Java or “classes” you may need to re-install Java. 
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21.7 Australian MEDICARE Problems 

You need to purchase the MEDICARE extension and install the software from the 

supplied DVD before the software can be used to claim. 

First of all look at the MEDICARE software log from the Australia menu. This is 

verbose, but should indicate if you have basic problems such as out-of-date site certificates. 

We have seen a case where claims suddenly failed with an undefined error. Try 

removing the .medicareonline folder in your home directory (e.g. on windows 

C:\Users\lloyd\.medicareonline, on unix clones the hidden directory  

/usr/home/.medicareonline), or just the files within the directory. 
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22.0  UPDATING CLEVERPSYCH 

22.1 Overview 

When you download and install a new version of CleverPsych, a new CleverPsych folder will 

be created that contains the new version of the software, and a new CleverDemo folder will 

also be created that contains the latest versions of all the support files and a demonstration 

database. 

It is recommended that you back up your existing CleverPsych and CleverData 

folders first  e.g. write them to a DVD. The installation scripts will usually make copies of the 

CleverPsych folders before the new folders are installed. 

After installation you can usually just restart CleverPsych and the system will update 

your files in the data folder. 

To use new features you may have to copy some files as described below. 

The best approach is probably to run up the demonstration and see what has changed. 

Changes are also described in the history on the web site. 

22.2 Common Changes 

Some files change quite often, and you need to copy the new versions from the new 

CleverDemo folder to your CleverData folder e.g. new or modified template files. In 

particular, the Example template is continually expanded to show new features. 
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22.3 Upgrading to Version 5.2 

This version enables the hour range and minute interval of the diary to be specified. If 

you are running multiple versions of CleverPsych (one for each psychologist) on the same 

computer you can use different sets of colours. 

To enable these features you need to copy everything from the CleverDemo\scripts 

folder to the CleverData\script folder. There are 3 files, CleverDemo.cmd, CleverPsych.cmd 

and NimROD.cmd. 

You also need to copy the colour theme files *.theme from the CleverDemo\config to 

the CleverData\config folder. 

See the RUNTIME CONFIGURATION chapter. 

22.4 Upgrading after Version 5.3 

The database and  files will usually be upgraded automatically. 
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APPENDIX A 

LEGAL 

THE CLEVER COMPANY MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY KIND 

WHATSOEVER WITH RESPECT TO THE SERVICE AND/OR THE PERFORMANCE OF THE 

PRODUCT; INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF 

MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. THE CLEVER COMPANY 

DOES NOT WARRANT, GUARANTEE OR MAKE ANY REPRESENTATION REGARDING THE 

USE, OR THE RESULTS OF THE USE, OF THE SERVICE AND/OR THE PRODUCT IN TERMS 

OF CORRECTNESS, ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE 

ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE SERVICE AND THE 

PRODUCT IS ASSUMED BY THE END USER. THE CLEVER COMPANY SHALL NOT BE 

LIABLE TO END USER FOR ANY CONSEQUENTIAL OR INCIDENTAL DAMAGES ARISING 

FROM THE BREACH OF ANY WARRANTIES, THE FAILURE OF DELIVERY, DELAY IN 

DELIVERY, DELIVERY IN NONCONFORMING CONDITION, THE USE OF THE SERVICE 

AND/OR THE PRODUCT, OR FOR ANY OTHER BREACH OF CONTRACT OR DUTY BETWEEN 

THE CLEVER COMPANY AND THE END USER. 
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APPENDIX B 

DATE FORMATS 

Date formats are those for the Java SimpleDateFormat class. This is an 

extract from the Java documentation. 

 

 

For more information search the net. 

22.4.1.1 DATE AND TIME PATTERNS 

Date and time formats are specified by date and time pattern strings. Within date and time 

pattern strings, unquoted letters from 'A' to 'Z' and from 'a' to 'z' are interpreted as 

pattern letters representing the components of a date or time string. Text can be quoted using 

single quotes (') to avoid interpretation. "''" represents a single quote. All other characters 

are not interpreted; they're simply copied into the output string during formatting or matched 

against the input string during parsing.  

The following pattern letters are defined (all other characters from 'A' to 'Z' and from 'a' 

to 'z' are reserved):  

L

etter  

Date or Time 

Component  

Presentati

on  

Examples  

G

  
Era designator  Text  AD  

y

  
Year  Year  1996; 96  

file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23text%23text
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23year%23year
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M

  
Month in year  Month  July; Jul; 07  

w

  
Week in year  Number  27  

W

  
Week in month  Number  2  

D

  
Day in year  Number  189  

d

  
Day in month  Number  10  

F

  

Day of week in 

month  

Number  2  

E

  
Day in week  Text  Tuesday; Tue  

a

  
Am/pm marker  Text  PM  

H

  

Hour in day (0-

23)  

Number  0  

k

  

Hour in day (1-

24)  

Number  24  

K

  

Hour in am/pm 

(0-11)  

Number  0  

h

  

Hour in am/pm 

(1-12)  

Number  12  

m Minute in hour  Number  30  

file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23month%23month
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23text%23text
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23text%23text
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
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s

  
Second in minute  Number  55  

S

  
Millisecond  Number  978  

z

  
Time zone  

General 

time zone  

Pacific Standard Time; PST; 

GMT-08:00  

Z

  
Time zone  

RFC 822 

time zone  

-0800  

Pattern letters are usually repeated, as their number determines the exact presentation:  

• Text: For formatting, if the number of pattern letters is 4 or more, the full form is 

used; otherwise a short or abbreviated form is used if available. For parsing, both 

forms are accepted, independent of the number of pattern letters.  

• Number: For formatting, the number of pattern letters is the minimum number of 

digits, and shorter numbers are zero-padded to this amount. For parsing, the number 

of pattern letters is ignored unless it's needed to separate two adjacent fields.  

• Year: If the formatter's Calendar is the Gregorian calendar, the following rules are 

applied. 

o For formatting, if the number of pattern letters is 2, the year is truncated to 2 

digits; otherwise it is interpreted as a number.  

o For parsing, if the number of pattern letters is more than 2, the year is 

interpreted literally, regardless of the number of digits. So using the pattern 

"MM/dd/yyyy", "01/11/12" parses to Jan 11, 12 A.D.  

o For parsing with the abbreviated year pattern ("y" or "yy"), 

SimpleDateFormat must interpret the abbreviated year relative to some 

century. It does this by adjusting dates to be within 80 years before and 20 

years after the time the SimpleDateFormat instance is created. For example, 

using a pattern of "MM/dd/yy" and a SimpleDateFormat instance created on 

Jan 1, 1997, the string "01/11/12" would be interpreted as Jan 11, 2012 while 

the string "05/04/64" would be interpreted as May 4, 1964. During parsing, 

only strings consisting of exactly two digits, as defined by 

Character.isDigit(char), will be parsed into the default century. Any 

other numeric string, such as a one digit string, a three or more digit string, or 

a two digit string that isn't all digits (for example, "-1"), is interpreted literally. 

So "01/02/3" or "01/02/003" are parsed, using the same pattern, as Jan 2, 3 

AD. Likewise, "01/02/-3" is parsed as Jan 2, 4 BC.  

file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23timezone%23timezone
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23timezone%23timezone
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23rfc822timezone%23rfc822timezone
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23rfc822timezone%23rfc822timezone
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/DateFormat.html%23getCalendar()
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/lang/Character.html%23isDigit(char)
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Otherwise, calendar system specific forms are applied. For both formatting and 

parsing, if the number of pattern letters is 4 or more, a calendar specific long form is 

used. Otherwise, a calendar specific short or abbreviated form is used.  

• Month: If the number of pattern letters is 3 or more, the month is interpreted as text; 

otherwise, it is interpreted as a number.  

• General time zone: Time zones are interpreted as text if they have names. For time 

zones representing a GMT offset value, the following syntax is used:  
•      GMTOffsetTimeZone: 

•              GMT Sign Hours : Minutes 

•      Sign: one of 

•              + - 

•      Hours: 

•              Digit 

•              Digit Digit 

•      Minutes: 

•              Digit Digit 

•      Digit: one of 

             0 1 2 3 4 5 6 7 8 9 

Hours must be between 0 and 23, and Minutes must be between 00 and 59. 

The format is locale independent and digits must be taken from the Basic Latin block 

of the Unicode standard.  

For parsing, RFC 822 time zones are also accepted.  

• RFC 822 time zone: For formatting, the RFC 822 4-digit time zone format is used:  
•      RFC822TimeZone: 

•              Sign TwoDigitHours Minutes 

•      TwoDigitHours: 

             Digit Digit 

TwoDigitHours must be between 00 and 23. Other definitions are as for 

general time zones.  

For parsing, general time zones are also accepted.  

SimpleDateFormat also supports localized date and time pattern strings. In these 

strings, the pattern letters described above may be replaced with other, locale dependent, 

file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/util/Calendar.html%23LONG
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/util/Calendar.html%23SHORT
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23text%23text
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23number%23number
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23text%23text
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23rfc822timezone%23rfc822timezone
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23timezone%23timezone
file:///C:/Users/lloyd/Dropbox/CleverPsychWorkspace11_0/java/docs/api/java/text/SimpleDateFormat.html%23timezone%23timezone
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pattern letters. SimpleDateFormat does not deal with the localization of text other than the 

pattern letters; that's up to the client of the class.  

22.4.1.2 EXAMPLES 

The following examples show how date and time patterns are interpreted in the U.S. 

locale. The given date and time are 2001-07-04 12:08:56 local time in the U.S. Pacific Time 

time zone.  

Date and Time Pattern  Result  

"yyyy.MM.dd G 'at' 

HH:mm:ss z"  
2001.07.04 AD at 12:08:56 PDT  

"EEE, MMM d, ''yy"  Wed, Jul 4, '01  

"h:mm a"  12:08 PM  

"hh 'o''clock' a, zzzz"  
12 o'clock PM, Pacific 

Daylight Time  

"K:mm a, z"  0:08 PM, PDT  

"yyyyy.MMMMM.dd GGG 

hh:mm aaa"  
02001.July.04 AD 12:08 PM  

"EEE, d MMM yyyy 

HH:mm:ss Z"  
Wed, 4 Jul 2001 12:08:56 -0700  

"yyMMddHHmmssZ"  010704120856-0700  

"yyyy-MM-

dd'T'HH:mm:ss.SSSZ"  
2001-07-04T12:08:56.235-0700  

 

 


